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Preface

This guide explains how to install Cisco Finesse and how to perform initial configuration tasks so that agents
can sign in to the Finesse desktop.

• Change History, page vii

• About This Guide, page viii

• Audience, page viii

• Organization, page viii

• Related Documents, page viii

• Obtaining Documentation and Submitting a Service Request, page ix

• Field Alerts and Field Notices, page ix

• Documentation Feedback, page ix

• Conventions, page ix

Change History
This table lists and links to changes made to this guide and gives the dates those changes were made. Earliest
changes appear in the bottom rows.

LinkDateChange

Install Language Pack, on page 25July 9, 2014Added link to software download
site.

Added reference to the Cisco
Finesse Administration Guide for
more information about supported
languages.

June 4, 2014Initial release of document
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About This Guide
The Cisco Finesse Installation and Upgrade Guide describes how to install Finesse, upgrade Finesse, and
perform initial configuration.

Audience
This guide is prepared for system engineers and administrators who are responsible for the installation and
initial configuration of Cisco Finesse.

Organization
ContentSection

Describes system requirements and preinstallation tasks
for Cisco Finesse

Chapter 1: Installation Preparation, on page
1

Provides an overview of the installation process and
describes how to install Cisco Finesse and troubleshoot
installation problems

Chapter 2: Cisco Finesse Server Installation,
on page 9

Lists the supported upgrade paths and describes how to
perform an upgrade and a rollback

Chapter 3: Upgrade, on page 17

Describes postinstallation tasks required to configure Cisco
Finesse

Chapter 4: Initial Configuration, on page 21

Lists the CLI commands supported for Cisco FinesseAppendix A: Cisco Finesse CLI, on page 41

Lists the network and system services used for Cisco
Finesse

Appendix B: Network and System Services
Used for Cisco Finesse, on page 47

Related Documents
LinkDocument or resource

http://www.cisco.com/en/US/partner/products/ps11324/products_
documentation_roadmaps_list.html

Cisco FinesseDocumentationGuide

http://www.cisco.com/en/US/partner/products/ps11324/tsd_products_
support_series_home.html

Cisco.com site for Finesse
documentation

http://docwiki.cisco.com/wiki/Cisco_FinesseDoc Wiki for Finesse
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LinkDocument or resource

http://docwiki.cisco.com/wiki/Troubleshooting_Cisco_FinesseTroubleshooting tips for Cisco
Finesse

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service
request, and gathering additional information, seeWhat's New in Cisco Product Documentation at http://
www.cisco.com/c/en/us/td/docs/general/whatsnew/whatsnew.html.

Subscribe toWhat's New in Cisco Product Documentation, which lists all new and revised Cisco technical
documentation as an RSS feed and delivers content directly to your desktop using a reader application. The
RSS feeds are a free service.

Field Alerts and Field Notices
Cisco products may be modified or key processes may be determined to be important. These are announced
through use of the Cisco Field Alerts and Cisco Field Notices. You can register to receive Field Alerts and
Field Notices through the Product Alert Tool on Cisco.com. This tool enables you to create a profile to receive
announcements by selecting all products of interest.

Log into www.cisco.com and then access the tool at http://www.cisco.com/cisco/support/notifications.html.

Documentation Feedback
To provide comments about this document, send an email message to the following address:
contactcenterproducts_docfeedback@cisco.com

We appreciate your comments.

Conventions
This document uses the following conventions:

DescriptionConvention

Boldface font is used to indicate commands, such as user entries, keys, buttons,
and folder and submenu names. For example:

• Choose Edit > Find.

• Click Finish.

boldface font
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DescriptionConvention

Italic font is used to indicate the following:

• To introduce a new term. Example: A skill group is a collection of agents
who share similar skills.

• A syntax value that the user must replace. Example: IF (condition, true-value,
false-value)

• A book title. Example: See the Cisco Unified Contact Center Enterprise
Installation and Upgrade Guide .

italic font

Window font, such as Courier, is used for the following:

• Text as it appears in code or that the window displays. Example:
<html><title>Cisco Systems, Inc. </title></html>

window font

Angle brackets are used to indicate the following:

• For arguments where the context does not allow italic, such as ASCII output.

• A character string that the user enters but that does not appear on the window
such as a password.

< >
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C H A P T E R  1
Installation Preparation

Cisco Finesse can be installed stand-alone in a deployment with Unified Contact Center Enterprise (Unified
CCE) or coresident in a deployment with Unified Contact Center Express (Unified CCX).

This guide describes how to install a stand-alone Finesse for deployment with Unified CCE.

In a coresident deployment with Unified CCX, Finesse is installed when you run the installer for Unified
CCX. For more information, see the Cisco Unified Contact Center Express Installation and Upgrade Guide.

Cisco Finesse is installed on a virtual machine as a primary or secondary node. The installation screens refer
to the primary node as the first node.

Finesse is installed on the Linux-based Unified Communications Operating System. This system is an
appliancemodel or “closed box” developed by Cisco, which does not support navigation into or manipulation
of the file system.

This guide specifies all supported configurations for this release of Cisco Finesse. If a configuration is
not stated, that configuration is not supported.

Important

• System Requirements, page 1

• Preinstallation Tasks, page 4

System Requirements
This section provides a summary of the requirements for Cisco Finesse.

Platform Requirements
All Finesse servers run on virtual machines (VM) using the Unified Communications Operating System
(Unified OS). ESXi 4.1 must be installed before you install Cisco Finesse.

For more information about supported VMs and VMware requirements, see the DocWiki page Virtualization
for Cisco Finesse.
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Client Requirements
No Finesse software is installed on the clients. Agents and supervisors use a web browser to access the Finesse
desktop. Administrators use a web browser to access the Finesse administration console. The following table
lists the supported operating systems and browsers for Finesse clients.

Browser VersionOperating System

Internet Explorer 9.0

Internet Explorer 11.0

IE 11 requires Windows 7
SP1.

Note

Firefox (version 24 or later)

Windows 7

Internet Explorer 11.0

Firefox (version 24 or later)

Windows 8.1

Firefox (version 24 or later)Mac OS X

Requirements, such as processor speed and RAM, for clients that access the Finesse desktop can vary.
Desktops that receive events for more than one agent (such as a supervisor desktop running Team
Performance and Queue Statistics gadgets or an agent desktop running Live Data reports that contain
information about other agents or skill groups) require more processing power than desktops that receive
events for a single agent.

Factors that determine how much power is required for the client include, but are not limited to, the
following:

Important

• Contact center traffic

• Additional integrated gadgets in the desktop (such as Live Data reports or third-party gadgets)

• Other applications that run on the client and share resources with the Finesse desktop

Network Requirements
For optimal Finesse performance, network characteristics should not exceed the following threshold:

• Latency: 80 ms (round-trip) between Finesse servers and 400 ms (round-trip) from Finesse client to
Finesse server

For information about bandwidth requirements for Cisco Finesse, see the Cisco Finesse Bandwidth Calculator.
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System Account Privileges
During the installation of Cisco Finesse, you must specify credentials for the following:

• Administrator User account: This account is used to access the CLI.

• Application User account: This account is used to access the Finesse administration console.

• Database access security password: This password is required if you replace or add a server in the
future or if you want to replace the security password with a new one. Keep a record of this password.

The database security password and the passwords for the Administrator and Application User accounts must
be at least six characters long. They can contain alphanumeric characters, hyphens, and underscores.

Security Considerations
The Cisco Finesse administration console and agent desktop support both HTTP and secure HTTP (HTTPS).
Administrators can run a CLI command to enable or disable Cisco Finesse HTTPS Redirect for the
administration console and the desktop.When Cisco Finesse HTTPSRedirect is enabled, agents and supervisors
who attempt to access the desktop through HTTP are redirected to HTTPS.

Cisco Finesse HTTPS Redirect is enabled by default. After you install Finesse, if you want to use HTTP, you
must run the CLI command to disable Cisco Finesse HTTPS Redirect.

When you upgrade Finesse, the setting for Cisco Finesse HTTPS Redirect is maintained. If Cisco Finesse
HTTPS Redirect is disabled on your system before you upgrade, it remains disabled after you upgrade.

HTTPS is not supported for large deployments with more than 1000 users.Note

To eliminate browser security warnings each time you access the administration console or agent desktop
through HTTPS, you can obtain and upload a CA certificate or you can use the self-signed certificate provided
with Finesse.

This guide uses HTTP for all example URLs.

Related Topics

Accept Security Certificates, on page 33
Obtain and Upload CA Certificate, on page 29
Cisco Finesse HTTPS Redirect, on page 43

Installation Spanning Multiple Domains
You can install the Finesse nodes on separate domains as long as the following requirements are met:

• Each Finesse server can perform a DNS lookup of the other using the fully-qualified domain name
(FQDN).

• All Finesse clients can perform DNS lookups of the Finesse servers using the FQDN.
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Other Requirements and Considerations
• You must have access to a Network Time Protocol (NTP) server.

• You must have a valid hostname and domain.

• Choose the Finesse hostname, domain, Primary and Secondary DNS, and IP address carefully. After
you install Finesse, you cannot change these values.

• You must have a preconfigured default router.

• You must have a preconfigured Domain Name Server (DNS) and have set up forward and reverse DNS.

• Finesse is supported on a Call Manager Peripheral Gateway (PG) and a Generic PG. Finesse does not
support a System PG. On a System PG, assuming that a Voice Response Unit (VRU) is also set up for
queuing, Finesse would receive queuing events meant for the VRU.

• The Finesse server uses Windows authentication to access the Administration & Data server database
(AWDB). You can set the MS SQL server authentication mode to either Windows Authentication or
Mixed.

• Finesse requires a domain user that is configured with login and read permissions to access the AWDB.

• The Finesse JDBC driver is configured to use NTLM. Make sure the AWDB is also configured to use
NTLM.

Finesse does not support NTLMv2. If the AWDB is configured to use NTLMv2, Finesse
cannot connect to the AWDB.

Note

• The port for the primary and backup Administration & Data Servers must be the same.

• If you plan to use Cisco Unified Customer Voice Portal (Unified CVP) for queuing, configure Unified
CVP to support warm transfer and conference, as described in the section Using the Warm Transfer
feature with SIP Calls in the Configuration and Administration Guide for Cisco Unified Customer Voice
Portal and the section Network Transfer in the Cisco Unified Customer Voice Portal Solutions Reference
Network Design.

• In Cisco Unified Communications Manager Administration, under Device > Phone, ensure that the
Maximum Number of Calls is set to no more than 2 and Busy Trigger is set to 1.

Preinstallation Tasks
Before you can install Cisco Finesse, complete the following preinstallation tasks:

• Record your network and password information on the configuration worksheet.

• Obtain the installation files.
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Configuration Worksheet
Use this configuration worksheet to record network and password information that is required to install and
configure Finesse. Store this worksheet information for future reference.

Many of the values that you enter on the installation configuration screens (such as hostnames, user IDs,
and passwords) are case-sensitive.

Note

Table 1: Configuration Worksheet

NotesYour EntryConfiguration Data

The hostname cannot be “local
host”. The hostname must be
the hostname of the server as
registered in the DNS.

__________________________Hostname

__________________________IP Address and Mask

__________________________Gateway (GW) Address

__________________________Primary DNS IP Address

__________________________Secondary DNS IP Address
(optional)

__________________________Domain

This account is used to access
the Finesse CLI.

Administrator User ID:
________________________

Administrator User password:
________________________

Administrator User
credentials

__________________________Timezone

Organization:__________________________

Unit:__________________________

Location:__________________________

State:__________________________

Country:__________________________

Certificate Information

NTP Server 1:
__________________________

NTP Server 2:
__________________________

NTP Server Host Name or
IP Address

Cisco Finesse Installation and Upgrade Guide Release 10.5(1)    
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NotesYour EntryConfiguration Data

__________________________Database Access Security
Password

This account is used to sign in
to the Finesse administration
console.

Application User ID:
________________________

Application User Password:
_____________________

Application User credentials

The hostname or IP address of
the A Side CTI server.

__________________________A Side CTI Server
Hostname/IP Address

The port of the A Side CTI
server.

__________________________A Side CTI Server Port

The hostname or IP address of
the B Side CTI server.

__________________________B Side CTI Server
Hostname/IP Address

The port of the B Side CTI
server.

__________________________B Side CTI Server Port

The ID of the CallManager
Peripheral Gateway (PG).

__________________________Peripheral ID

The hostname or IP address of
the primary Unified CCE
Administration & Data server.

__________________________Primary Administration &
Data Server Hostname/IP
Address

The hostname or IP address of
the backup Unified CCE
Administration & Data server.

__________________________Backup Administration &
Data Server Hostname/IP
Address

The port of the Unified CCE
Administration & Database
server.

The port must be the same for
the primary and backup
Administration&Data servers.

__________________________Database Port

The name of the AWDatabase
(AWDB).

For example,
ucceinstance_awdb.

__________________________AW Database Name

The domain of the AWDB.__________________________Domain
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NotesYour EntryConfiguration Data

This user refers to the
Administrator Domain user
that the AWDB uses to
synchronize with the Logger.

The AWDB server must use
Windows authentication and
the configured username must
be a domain user.

__________________________Username to access the
AWDB

__________________________Password to access the
AWDB

__________________________Hostname/IP address of the
secondary Finesse server

Related Topics

System Account Privileges, on page 3

Installation Files
Before you install Finesse, you must obtain the OVA files. Finesse supports two OVA templates. Choose the
OVA template you need based on the size of your deployment.

For small deployments (up to 500 agents over HTTP or 250 agents over HTTPS), you need the following
files:

• Finesse_500_HTTP_agents_or_250_HTTPS_agents_v10.5.1_vmv8.ova
This file is the VM template file that you deploy in your installation.

• Finesse_500_HTTP_agents_or_250_HTTPS_agents_v10.5.1_vmv8.ova.README text file

This file contains the format that is supported by the OVA file and the instructions to import it and to
edit the VM settings.

• Finesse_500_HTTP_agents_or_250_HTTPS_agents_v10.5.1_vmv8.ova.md5
This file is a verification file (a checksum that is calculated on the OVA file to ensure it is not modified
or corrupted). You can run the following command in Linux to verify the checksum: md5sum
Finesse_500_HTTP_agents_or_250_HTTPS_agents_v10.5.1_vmv8.ova

For large deployments (up to 2000 agents over HTTP or 1000 agents over HTTPS), you need the following
files:

• Finesse_2000_HTTP_agents_or_1000_HTTPS_agents_v10.5.1_vmv8.ova
This file is the VM template file that you must deploy in your installation.

• Finesse_2000_HTTP_agents_or_1000_HTTPS_agents_v10.5.1_vmv8.ova.README text file

Cisco Finesse Installation and Upgrade Guide Release 10.5(1)    
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This file contains the format that is supported by the OVA file and the instructions to import it and to
edit the VM settings.

• Finesse_2000_HTTP_agents_or_1000_HTTPS_agents_v10.5.1_vmv8.ova.md5
This file is a verification file (a checksum that is calculated on the OVA file to ensure it is not modified
or corrupted). You can run the following command in Linux to verify the checksum: md5sum
Finesse_2000_HTTP_agents_or_1000_HTTPS_agents_v10.5.1_vmv8.ova.md5

You must purchase the Finesse media kit to obtain the installer. For more information, see theOrdering Guide
for Cisco Customer Contact Solutions (http://www.cisco.com/web/partners/downloads/partner/WWChannels/
technology/ipc/downloads/CCBU_ordering_guide.pdf).

You can obtain the Cisco Virtual Server (OVA) files needed to create a virtual machine from Cisco.com at
the following URL: http://software.cisco.com/download/type.html?mdfid=283613135&i=rml.
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C H A P T E R  2
Cisco Finesse Server Installation

Cisco Finesse server is installed on a virtual machine (VM). The installation runs from an ISO image and
uses an OVA template.

Configure a DataStore ISO file on the virtual CD/DVD drive of the target VM to install Finesse.Note

The installation takes about an hour. For most of that time, it can run unattended. Much of the installation
requires no action on the part of the person who runs it. When user input is required, use the following
keyboard navigation and selection actions. The installation wizard screens do not recognize a mouse or a
touchpad.

Press this keyTo do this

TabMove to the next field

Alt-TabMove to the previous field

SpacebarSelect an option

Up or Down Arrow keysScroll up or down a list

Tab to Back and press the SpacebarGo to the previous screen

Tab to Help and press the SpacebarGet information about a screen

• Installation Task Flow, page 10

• Install Finesse on Primary Node, page 10

• Install Finesse on Secondary Node, page 13

• Installation Troubleshooting, page 16

Cisco Finesse Installation and Upgrade Guide Release 10.5(1)    
9



Installation Task Flow
The following table provides an overview of the tasks you perform to install Cisco Finesse. Tasks must be
performed in the order they are listed.

See Install Finesse on Primary Node, on page 10.Install Finesse on the primary node.1

See Configure Contact Center Enterprise CTI Server
Settings, on page 21.

Configure the CTI server settings.2

See Configure Contact Center Enterprise Administration
& Data Server Settings, on page 23.

Configure the database settings.3

See Configure Cluster Settings, on page 24.Configure the cluster settings for the
secondary node.

4

See Restart Cisco Tomcat, on page 24.Restart Cisco Tomcat on the primary
node.

5

See Install Finesse on Secondary Node, on page 13.Install Finesse on the secondary node.6

See Check Replication Status, on page 25.Ensure replication is functioning
between the two nodes.

7

Install Finesse on Primary Node
Procedure

Step 1 Follow the instructions in the OVA README.txt file to import and deploy the OVA, to edit VM settings,
and to power on the VM and edit the BIOS settings in the console. For more information, see the section on
Installation Files.

Do not use Thin Provisioning or a VM snapshot when creating a VM to host Cisco Finesse. The use
of Thin Provisioning or snapshots can negatively impact the performance of Cisco Finesse operation.

Note

Messages appear while the preinstallation script runs. When the preinstallation script ends, the DVD Found
screen opens.

Step 2 Select OK on the Disk Found screen to begin the verification of the media integrity and a brief hardware
check.
If the media check passes, select OK to open the Product Deployment Selection screen. Continue to Step 3.

If the media check fails, the installation terminates.

Step 3 The Product Deployment Selection screen states that the Cisco Finesse product suite will be installed. This
screen has only one choice: OK.
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Select OK to open the Proceed with Install screen.

Step 4 The Proceed with Install screen shows the version of the product that is currently installed (if any) and the
version of the product for this ISO. For the initial installation, the version currently installed shows NONE.
Select Yes on the Proceed with Install screen to open the Platform Installation Wizard screen.

Step 5 On the Platform Installation Wizard screen, select Proceed to open the Basic Install screen.
Step 6 Select Continue on the Basic Install screen to open the Basic Install wizard.

The Basic Install wizard presents a series of screens that present questions and options pertinent to the platform
and the setup configuration. Help is available for each wizard screen.

The first Basic Install wizard screen is Timezone Configuration.

Step 7 On the Timezone Configuration screen:
a) Use the up and down arrows to locate the local time zone that most closely matches your server location.

You can also type the initial character of the time zone to move to that item in the list. The Timezone field
is based on country and city and is mandatory. Setting it incorrectly can affect system operation.

b) Select OK to open the Auto Negotiation Configuration screen.

Step 8 On the Auto Negotiation Configuration screen, select Yes to use automatic negotiation for the settings of the
Ethernet network interface card (NIC).
Your selection of Yes opens the MTU Configuration screen.

Step 9 In the MTU Configuration screen, select No to keep the default setting for Maximum Transmission Units
(1500).

Finesse supports the default setting of 1500 forMTU only. No other value is supported.Note

Your selection of No opens the Static Network Configuration screen.

Step 10 On the Static Network Configuration screen, enter static network configuration values as follows, referring
to the Configuration Worksheet if necessary:
a) Enter the Host Name.
b) Enter the IP Address.
c) Enter the IP Mask.
d) Enter the GW Address.
e) Select OK to open the Domain Name System (DNS) Client Configuration screen.

Step 11 On the DNS Client Configuration screen, select Yes to specify the DNS client information.
DNS client configuration ismandatory for Cisco Finesse. Select Yes on this screen. If you select
No, after the installation is complete, agents cannot sign in to the desktop and you have to reinstall
Finesse.

Important

Step 12 Specify your DNS client information as follows, referring to the Configuration Worksheet if necessary:
a) Enter the Primary DNS (mandatory).
b) Enter the Secondary DNS (optional).
c) Enter the Domain (mandatory).
d) Select OK to open the Administrator Login Configuration screen.

Step 13 On the Administrator Login Configuration screen:
a) Enter the credentials for the administrator.
b) Select OK to open the Certificate Information screen.

Step 14 On the Certificate Information screen:
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a) Enter the following data to create your Certificate Signing Request: Organization, Unit, Location, State,
and Country.

b) Select OK to open the First Node Configuration screen.

Step 15 On the First Node Configuration screen, select Yes to indicate that you are configuring the first node.
Your selection of Yes opens the Network Time Protocol Client Configuration screen.

Step 16 On the Network Time Protocol Client Configuration screen, enter the IP address, NTP server name, or NTP
Server Pool name for at least one external NTP server.

Step 17 After you complete the NTP configuration, select OK. This action opens the Security Configuration screen.
Step 18 On the Security Configuration screen, enter the Database Access Security password, and then select OK.
Step 19 On the Application User Configuration screen, enter the credentials for the application user.

Select OK to open the Platform Configuration Confirmation screen. This screen states that the platform
configuration is complete.

Step 20 On the Platform Configuration Confirmation screen, select OK.
The installation begins.

The installation can take up to an hour to complete and can run unattended for most of that time.

During the installation, the monitor shows a series of processes, as follows:

• Formatting progress bars

• Copying File progress bar

• Package Installation progress bars

• Post Install progress bar

• Populate RPM Archive progress bar

• Application Installation progress bars (multiple Component Install screens, security checks)

• An informational screen saying the system will reboot momentarily to continue the installation

If you see the following virtual machine question, select Yes, and then click OK:

Figure 1: Virtual Machine Message

• A system reboot

Messages stream down your monitor during the reboot. Some of them prompt you to press a key. Do
not respond to these prompts to press a key.
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• Application Pre Install progress bars

• Configure and Setup Network progress bars
If a Network Connectivity Failure screen appears during the Configure and Setup Network
process, click Review, and then click OK at the Errors screen. Follow the prompts to reenter
the information that caused the failure. The installation continues when the connection
information is complete.

Note

• Security configuration

A message appears that states the installation of Cisco Finesse has completed successfully.
The installation of Cisco Finesse has completed successfully.

Cisco Finesse <version number>
<hostname> login: _

Step 21 Access the CLI and run the following command to restart Finesse:
utils system restart

What to Do Next

Sign in to the Finesse administration console on the primary Finesse server (http://FQDN, hostname, or IP
address of Finesse server/cfadmin) to configure CTI server, Administration & Database server, and cluster
settings.

After you configure these settings, install Finesse on the secondary node.

Related Topics

Configuration Worksheet, on page 5
Configure Contact Center Enterprise CTI Server Settings, on page 21
Configure Contact Center Enterprise Administration & Data Server Settings, on page 23
Configure Cluster Settings, on page 24
Cisco Finesse CLI, on page 41

Install Finesse on Secondary Node
Install the same version of Finesse on both the primary and secondary Finesse nodes.

Configure a Datastore ISO file on the virtual CD/DVD drive of the target VM to install Finesse.Note

Finesse administration tasks can only be performed on the primary Finesse server. After you install the
secondary server, sign in to the administration console on the primary server to perform administration
tasks (such as configuring reason codes or call variable layout).

Note

Before You Begin

• Install Finesse on the primary server. See Install Finesse on Primary Node.
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• Use the Finesse administration console on the primary Finesse server to configure CTI server,
Administration & Database server, and cluster settings.

• Ensure that the DNS server has forward and reverse DNS set up for both the primary and secondary
node.

Procedure

Step 1 Follow the instructions in the OVA README.txt file to import and deploy the OVA, to edit VM settings,
and to power on the VM and edit the BIOS settings in the Console.
Messages appear while the preinstallation script runs. When the preinstallation script ends, the DVD Found
screen opens.

Step 2 Select Yes on the DVD Found screen to begin the verification of the media integrity and a brief hardware
check.
If the media check passes, select OK to open the Product Deployment Selection screen. Continue to Step 3.

If the media check fails, the installation terminates.

Step 3 The Product Deployment Selection screen states that the Cisco Finesse product suite will be installed. This
screen has only one choice: OK.
Select OK to open the Proceed with Install screen.

Step 4 The Proceed with Install screen shows the version of the product that is currently installed (if any) and the
version of the product for this ISO. For the initial installation, the version currently installed shows NONE.
Select Yes on the Proceed with Install screen to open the Platform Installation Wizard screen.

Step 5 On the Platform Installation Wizard screen, select Proceed to open the Basic Install screen.
Step 6 Select Continue on the Basic Install screen to open the Basic Install wizard.

The Basic Install wizard presents a series of screens that present questions and options pertinent to the platform
and the setup configuration. Help is available for each wizard screen.

The first Basic Install wizard screen is Timezone Configuration.

Step 7 In the Timezone Configuration screen:
a) Use the up and down arrows to locate the local time zone that most closely matches your server location.

You can also type the initial character of the time zone to move to that item in the list. The Timezone field
is based on country and city and is mandatory. Setting it incorrectly can affect system operation.

b) Select OK to open the Auto Negotiation Configuration screen.

Step 8 On the Auto Negotiation Configuration screen, select Yes to use automatic negotiation for the settings of the
Ethernet network interface card (NIC).
Your selection of No opens the MTU Configuration screen.

Step 9 On the MTU Configuration screen, select No to keep the default setting for Maximum Transmission Units
(1500).

Finesse supports the default setting of 1500 forMTU only. No other value is supported.Note

Your selection of No opens the Static Network Configuration screen.

Step 10 On the Static Network Configuration screen, enter static network configuration values as follows, referring
to the Configuration Worksheet if necessary:
a) Enter the Host Name.
b) Enter the IP Address.
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c) Enter the IP Mask.
d) Enter the GW Address.
e) Select OK to open the Domain Name System (DNS) Client Configuration screen.

Step 11 On the DNS Client Configuration screen, select Yes to specify the DNS client information.
IMPORTANT: DNS client configuration is mandatory for Cisco Finesse. Select Yes on this screen. If you
select No, after the installation is complete, agents cannot sign in to the desktop and you have to reinstall
Finesse.

Step 12 Specify your DNS client information as follows, referring to the Configuration Worksheet if necessary:
a) Enter the Primary DNS (mandatory).
b) Enter the Secondary DNS (optional).
c) Enter the Domain (mandatory).
d) Select OK to open the Administrator Login Configuration screen.

Step 13 On the Administrator Login Configuration screen:
a) Enter the credentials for the administrator.
b) Select OK to open the Certificate Information screen.

Step 14 On the Certificate Information screen:
a) Enter the following data to create your Certificate Signing Request: Organization, Unit, Location, State,

and Country.
b) Select OK to open the First Node Configuration screen.

Step 15 On the First Node Configuration screen, select No to indicate that you are configuring the second node.
A warning message appears that indicates you must first configure the server on the first node before you can
proceed. If you already configured the first node, select OK.

Step 16 On the Network Connectivity Test Configuration screen, select No to proceed with the installation after
connectivity is verified.

Step 17 On the First Node Configuration screen, specify the information about the first node as follows:
a) Enter the Host Name of the primary Finesse server.
b) Enter the IP Address of the primary Finesse server.
c) Enter the Security Password of the primary Finesse server.
d) Confirm the Security Password.

Step 18 Select OK to open the Platform Configuration Confirmation screen.
Step 19 On the Platform Configuration Confirmation screen, select OK.

The installation begins.

The installation can take up to an hour to complete and can run unattended for most of that time.

A message appears that states the installation of Cisco Finesse has completed successfully.
The installation of Cisco Finesse has completed successfully.

Cisco Finesse <version number>
<hostname> login: _

Step 20 Access the CLI and run the following command to restart Finesse:
utils system restart
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What to Do Next

Check the replication status. If all nodes in the cluster show a replication status of 2, replication is functioning
correctly.

It can take 10–20 minutes to establish replication fully between the two nodes.Note

Related Topics

Configuration Worksheet, on page 5
Install Finesse on Primary Node, on page 10
Configure Contact Center Enterprise CTI Server Settings, on page 21
Configure Contact Center Enterprise Administration & Data Server Settings, on page 23
Configure Cluster Settings, on page 24
Check Replication Status, on page 25
Cisco Finesse CLI, on page 41

Installation Troubleshooting
ThenIf

If the installation fails, a screen appears that asks if you want to copy
diagnostic information to a device.

In this situation, you must reinstall from the beginning, but first you
must attach a serial port to the VM. Then, you dump the install logs into
the serial port of the VM.

For more information about how to attach a serial port and dump the
install logs, see the DocWiki page How to Dump Install Logs to the
Serial Port of the Virtual Machine.

The installation fails.
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C H A P T E R  3
Upgrade

• Supported Upgrade Paths, page 17

• Perform Upgrade, page 18

• Perform Rollback, page 20

Supported Upgrade Paths
The following table lists the supported upgrade paths to Cisco Finesse Release 10.5(1).

Upgrade PathCurrent Version

1 Upgrade from current release to Release 9.1(1).

2 Upgrade from Release 9.1(1) to Release 9.1(1) SU1.

3 Upgrade from Release 9.1(1) SU1 to Release 10.5(1).

Release 9.0(1)

1 Upgrade from current release to Release 9.1(1) SU1.

2 Upgrade from Release 9.1(1) SU1 to Release 10.5(1).

Release 9.1(1)

Release 9.1(1) ES1

Release 9.1(1) ES2

Release 9.1(1) ES3

Release 9.1(1) ES4

Release 9.1(1) ES5

Upgrade to Release 10.5(1).Release 9.1(1) SU1

Release 9.1(1) SU1
ES1

1 Upgrade from Release 10.0(1) to Release 10.0(1) SU1.

2 Upgrade from Release 10.0(1) SU1 to Release 10.5(1).

Release 10.0(1)
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Upgrade PathCurrent Version

Upgrade to Release 10.5(1).Release 10.0(1) SU1

Cisco Finesse ISOs are bootable. For example, if you need to rebuild your secondary server, you can
upgrade your primary server to the latest release and then perform a fresh installation with the Finesse
ISO on your secondary server.

Note

Perform Upgrade
You must perform the upgrade on the primary Finesse node first, and then on the secondary Finesse node.
Both the primary and secondary Finesse nodes must be running the same version prior to the upgrade.

Before You Begin

• Perform a DRS backup on the primary Finesse server. To access the DRS application, direct your browser
to https://IP address of Finesse server:8443/drf. For more information, see the online help provided with
the DRS application.

You must perform a DRS backup before you perform the upgrade. If a problem occurs
with the upgrade and you need to roll back to the previous version, you need the DRS
backup to restore your system. If you do not use the DRS backup to restore your system,
replication to the second Finesse node breaks and cannot be repaired.

Important

• Place the Cisco Finesse ISO file on an FTP or SFTP server that you can access from your Finesse system
or burn the ISO file to DVD.

• If you have a custom desktop layout, save your current layout configuration. Sign in to the administration
console on the primary Finesse node (http://FQDN, hostname, or IP address of Finesse server/cfadmin).
Copy the layout XML file from the Manage Desktop Layout gadget on the Desktop Settings tab and
save it as a text file on your local system.

If you have never modified the desktop layout, it automatically upgrades to the new
layout. However, if you have previously modified the desktop layout, the upgrade retains
your modified layout. Keep the text file for reference. Youwill need to perform additional
steps after the upgrade is complete to restore your modified layout.

Note
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Procedure

Step 1 SSH to your Finesse system and log in with the platform administration account.
Step 2 Access the CLI and run the command utils system upgrade initiate.
Step 3 Follow the instructions provided by the utils system upgrade initiate command.

If you choose to install from a remote source (FTP or SFTP server), provide the location and credentials for
the remote file system.

If you choose to install from the local CD/DVD drive, ensure the drive is connected to the Finesse virtual
machine (VM) as follows:

a) Right-click the VM and choose Edit Settings.
b) Click the Hardware tab.
c) In the left pane, select CD/DVD Drive.
d) In the right pane, under Device Status, check the Connected and Connect at power on check boxes.
e) Under Device Type, select Datastore ISO File.
f) Click Browse and navigate to the Finesse ISO file.
g) Click OK.

Step 4 At the Automatically switch versions if the upgrade is successful prompt, type yes to upgrade and switch
version, or type no to upgrade only without switching version.

The upgrade is not active until a switch version is
performed.

Note

Step 5 At the Start installation (yes/no) prompt, type yes to start the upgrade.
Step 6 If you are installing from the local CD/DVD drive, when the upgrade enters the BIOS screen, on the Boot

tab, move CD-ROM Drive to the top, save your settings, and exit.
Step 7 After the upgrade is complete, disconnect the CD/DVD drive.

a) Right-click the VM and choose Edit Settings.
b) Click the Hardware tab.
c) Select CD/DVD Drive 1.
d) Uncheck the Connected and Connect at power on check boxes.
e) Click OK.

Step 8 Perform the preceding steps on the secondary Finesse server.
Step 9 Sign in to the Finesse desktop to verify that the upgrade was successful (http://FQDN, hostname, or IP address

of Finesse server).
After Finesse restarts, wait approximately 20 minutes before you attempt to sign in to the desktop.
Finesse services may take a few minutes to reach the STARTED state.

Note

What to Do Next

After a system upgrade, make sure all agents and supervisors clear their browser cache.

If you had a modified desktop layout before the upgrade, perform the following steps to ensure you obtain
the latest changes:

1 Sign in to the Finesse administration console and click the Desktop Layout tab.

2 On the Manage Desktop Layout gadget, click Restore Default Layout.
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3 Click Save.

4 Using the text file of the desktop layout that you saved before the upgrade as a reference, modify the layout
to include the changes that you made to the previous layout.

5 Click Save to save your changes.

In the Manage Reasons (Not Ready) gadget, check for Not Ready reason codes with code values that are not
unique. Edit any that you find to give them unique values.

In the Manage Reasons (Sign Out) gadget, check for Sign Out reason codes with code values that are not
unique. Edit any that you find to give them unique values.

Perform Rollback
If a problem occurs with the upgrade, you can roll back to the earlier release.

Procedure

Step 1 Perform a switch-version on the primary node.
a) Access the CLI and enter the command utils system switch-version.
b) Enter yes to confirm.

The system attempts to switch back to the original version and reboots if the switch is successful.

Step 2 Perform a switch-version on the secondary node.
Step 3 Perform a DRS restore.

Do not attempt to reset replication after you perform the switch-version. You must perform a DRS
restore. If you attempt to repair replication before you perform a DRS restore, the DRS restore will
not work correctly.

Note
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C H A P T E R  4
Initial Configuration

• Configure Contact Center Enterprise CTI Server Settings, page 21

• Configure Contact Center Enterprise Administration & Data Server Settings, page 23

• Configure Cluster Settings, page 24

• Restart Cisco Tomcat, page 24

• Check Replication Status, page 25

• Install Language Pack, page 25

• Ensure Agents Have Passwords, page 26

• Ensure Logout Non-Activity Time for Agents is Configured, page 26

• Configure Agent Phones, page 27

• Browser Settings for Internet Explorer, page 27

• Set Up Certificates, page 28

• Ensure Agents Can Sign in to Desktop, page 35

• Ensure Failover Functions Correctly, page 36

• Configure DNS on Clients, page 37

• Load Balancing for Finesse, page 38

• Initial Configuration Troubleshooting, page 39

Configure Contact Center Enterprise CTI Server Settings
Access the administration console on the primary Finesse server to configure the A Side and B Side CTI
servers.

After you restart Finesse, it can take approximately 6 minutes for all server-related services to restart.
Therefore, you should wait 6 minutes before you attempt to access the Finesse administration console.

Note
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If you are using HTTPS, the first time you access the administration console, you see a browser security
warning. To eliminate browser security warnings each time you sign in, you can trust the self-signed
certificate provided with Finesse or obtain and upload a CA certificate.

Note

Procedure

Step 1 Sign in to the administration console on the primary Finesse server:
http://FQDN hostname, or IP address of Finesse server/cfadmin

Step 2 Sign in with the Application User credentials defined during installation.
Step 3 In the Contact Center Enterprise CTI Server Settings area, enter the CTI server settings as described in the

following table. Refer to your configuration worksheet if necessary.
DescriptionField

Enter the hostname or IP address of the A Side CTI server.

This value is typically the IP address of the Peripheral Gateway (PG).
The CTI server runs on the PG.

A Side Host/IP Address

Enter the port number of the A Side CTI server. The value of this
field must match the port configured during the setup of the A Side
CTI server.

A Side Port

Enter the ID of the Agent PG Routing Client (PIM).

The Agent PG Peripheral ID should be configured to the same value
for the A Side and B Side CTI servers.

Peripheral ID

Enter the hostname or IP address of the B Side CTI server.B Side Host/IP Address

Enter the port of the B Side CTI server. The value of this field must
match the port configured during the setup of the B Side CTI server.

B Side Port

Step 4 Click Save.

Related Topics

System Account Privileges, on page 3
Configuration Worksheet, on page 5

   Cisco Finesse Installation and Upgrade Guide Release 10.5(1)
22

Initial Configuration
Configure Contact Center Enterprise CTI Server Settings



Configure Contact Center Enterprise Administration & Data
Server Settings

Configure the Contact Center Enterprise Administration & Data Server settings to enable authentication for
Finesse agents and supervisors.

Procedure

Step 1 If you are not already signed in, sign in to the administration console.
Step 2 In the Contact Center Enterprise Administration &Data Server Settings area, enter the Administration &Data

Server settings as described in the following table. Refer to your configuration worksheet if necessary.
DescriptionField

Enter the hostname or IP address of the Unified CCEAdministration
& Data Server.

Primary Host/IP Address

Enter the hostname or IP address of the backup Unified CCE
Administration & Data Server.

Backup Host/IP Address

Enter the port of the Unified CCE Administration & Data Server.

Because Finesse expects the primary and backup
Administration & Data Server ports to be the same, the
Finesse administration console exposes only one port field.
You must ensure that the port is the same for the primary
and backup Administration & Data Servers.

Note

Database Port

Enter the name of the AW Database (AWDB) (for example,
ucceinstance_awdb).

AW Database Name

Enter the domain of the AWDB.Domain

Enter the username required to sign in to the AWDB.Username

Enter the password required to sign in to the AWDB.Password

Step 3 Click Save.

Related Topics

Configuration Worksheet, on page 5
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Configure Cluster Settings
Configure the cluster settings for the secondary Finesse node. The secondary Finesse node handles agent
requests if the primary server goes down.

Procedure

Step 1 If you are not already signed in, sign in to the administration console with the Application User credentials.
Step 2 In the Cluster Settings area, in the Host/IP Address field, enter the hostname or IP address of the secondary

Finesse server.
Step 3 Click Save.

Related Topics

Configuration Worksheet, on page 5

Restart Cisco Tomcat
After youmake changes to the Contact Center Enterprise CTI Server, Contact Center Enterprise Administration
& Data Server, or cluster settings, you must restart Cisco Tomcat for the changes to take effect.

Procedure

Step 1 Access the CLI and run the following command:
utils service restart Cisco Tomcat

Step 2 You can enter the command utils service list to monitor the Cisco Tomcat Service. After Cisco Tomcat
changes to STARTED, agents who have passwords can sign in to the desktop.

Related Topics

Cisco Finesse CLI, on page 41
Finesse Services, on page 44
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Check Replication Status
Procedure

Step 1 Access the CLI on the primary Finesse server.
Step 2 Sign in with the Administrator User credentials defined during installation.
Step 3 Run the following command:

utils dbreplication runtimestate

This command returns the replication status on both the primary and secondary Finesse servers.

Related Topics

Cisco Finesse CLI, on page 41
Replication Status, on page 45

Install Language Pack
Download and install a language pack only if you want to use the Finesse desktop interface in a language
other than English.

The language pack for Finesse is delivered as a single Cisco Option Package (COP) file. The file is available
to download from Cisco.com and contains a single installer for all language variants.

You can download the language pack for Finesse at the following link:

https://software.cisco.com/download/
release.html?mdfid=283613135&softwareid=284259728&relind=AVAILABLE&rellifecycle=&reltype=latest

COP files can generally be installed on an active, running system. However, language COP files cannot be
removed or rolled back.

If the ReadMe file for a specific COP file contradicts these general guidelines, follow the instructions
provided with the file.

Note

For more information about supported languages, see the Cisco Finesse Administration Guide (http://
www.cisco.com/c/en/us/support/customer-collaboration/finesse/products-user-guide-list.html).
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Procedure

Step 1 Download the Finesse COP file from the Cisco Software site http://software.cisco.com/download/
type.html?mdfid=283613135&i=rm to a local source or an SFTP server that can be accessed by the Finesse
server.

Step 2 Use SSH to log in to your Finesse system with the platform administration account.
Step 3 Use the CLI to run the command utils system upgrade initiate.
Step 4 Follow the instructions provided by the utils system upgrade initiate command.
Step 5 Reboot the server.
Step 6 Repeat step 2 through step 5 on the secondary Finesse server.
Step 7 When the installation is complete on both Finesse servers, agents and supervisors must clear their browser

cache and cookies.

Ensure Agents Have Passwords
Agents who do not have a password defined in Unified CCEConfigurationManager cannot sign in to Finesse.

Agent password is an optional field in Unified CCE, but it is mandatory for Cisco Finesse.

For agents who do not have passwords, you must perform the following steps:

Procedure

Step 1 Launch Unified CCE Configuration Manager.
Step 2 Locate the record for the agent (Agent Explorer > Agent tab).
Step 3 Enter a password, and save the record.

Ensure Logout Non-Activity Time for Agents is Configured
The Logout non-activity time specifies how long an agent can remain inactive in the Not Ready state before
that agent is signed out of Finesse.

Perform the following steps to configure Logout non-activity time for an agent.
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Procedure

Step 1 Launch the Unified CCE Configuration Manager.
Step 2 Launch Agent Desk Settings List (Tools > List Tools).
Step 3 Select Agent Desk Settings List.
Step 4 In the Logout non-activity time field, enter the number of seconds of agent inactivity while in the Not Ready

state before the system software signs the agent out. You can enter a value between 10 seconds and 7200
seconds.

Step 5 Click Save.
The modified settings are applied to all of the agents who use these agent desktop settings.

Configure Agent Phones
Before agents can sign in to the Finesse desktop, you must ensure that the agent phones are configured in
Unified Communications Manager. For more information about configuring agent phones, see the “Agent
Phones” section of the Cisco Unified Contact Center Enterprise Design Guide (http://www.cisco.com/c/en/
us/support/customer-collaboration/unified-contact-center-enterprise/
products-implementation-design-guides-list.html).

Browser Settings for Internet Explorer
If Internet Explorer is used to access the Finesse desktop, certain settings must be configured in the browser
to ensure all features of Finesse work properly.

Disable pop-up blockers.

Finesse does not support Compatibility View. When the desktop is running in Compatibility View, Internet
Explorer renders in the standard mode for that version.

Configure the following privacy and advanced settings:

1 From the browser menu, select Tools > Internet Options.

2 Click the Privacy tab.

3 Click Sites.

4 In the Address of website box, enter the domain name for the Side A Finesse server.

5 Click Allow.

6 In the Address of website box, enter the domain name for the Side B Finesse server.

7 Click Allow.

8 Click OK.

You must enable the following security settings to allow users to sign in:

• Run ActiveX controls and plug-ins
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• Script ActiveX controls marked as safe for scripting

• Active scripting

To enable these settings:

1 From the Internet Explorer browser menu, select Tools > Internet Options.

2 Click the Security tab.

3 Click Custom level.

4 Under ActiveX controls and plug-ins, select Enable for Run ActiveX controls and plug-ins and Script
ActiveX controls marked safe for scripting.

5 Under Scripting, select Enable for Active Scripting.

If the customer is using self-signed CA (Certificate Authority) and their agents use the server's FQDN,
there should not be any cert errors or warnings when connecting to Finesse over HTTPS.

Note

Set Up Certificates
If you use HTTPS for communication between the Finesse desktop and Finesse server, you must set up security
certificates. Finesse provides a self-signed certificate that you can use or you can provide a CA certificate.
You can obtain a CA certificate from a third-party vendor or produce one internal to your organization.

Finesse does not support wildcard certificates. After you upload a root certificate signed by a Certificate
Authority, the self-signed certificates are overwritten.

If you use the Finesse self-signed certificate, agents must accept the security certificates the first time they
sign in to the desktop. If you use a CA certificate, you can accept it for the browser on each client or deploy
a root certificate using group policies.

If there is a mismatch between the server hostname and the hostname in the certificate, a warning message
is displayed in the IE browser about certificate address mismatch. The certificate must be re-generated so
that the hostname in the certificate matches the server hostname before importing to Finesse. If there is a
valid reason for the mismatch, you can uncheck theWarn about certificate address mismatch checkbox
from Tools > Internet Options > Advanced > Security to allow the certificate to be accepted.

Note

Server-Side Certificate Management
By default, Finesse comes with self-signed certificates. If you use these certificates, agents must complete a
procedure to accept the certificates the first time they sign in. To simplify the agent experience, you can obtain
and upload a CA certificate or produce your own certificate internally.
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Obtain and Upload CA Certificate

This procedure only applies if you are using HTTPS.

This procedure is optional. If you are using HTTPS, you can choose to obtain and upload a CA certificate
or you can choose to use the self-signed certificate provided with Finesse.

Note

To eliminate browser security warnings each time you sign in, obtain an application and root certificate signed
by a Certificate Authority (CA). Use the Certificate Management utility from Cisco Unified Communications
Operating System Administration.

To open Cisco Unified Communications Operating System Administration, enter the following URL in your
browser:

https://hostname of primary Finesse server/cmplatform

Sign in using the username and password for the Application User account created during the installation of
Finesse.

You can find detailed explanations in the Security topics of the Cisco Unified Communications Operating
System Administration Online Help.

Note

Procedure

Step 1 Generate a CSR.
a) Select Security > Certificate Management > Generate CSR.
b) From the Certificate Name drop-down list, select tomcat.
c) Click Generate CSR.

Step 2 Download the CSR.
a) Select Security > Certificate Management > Download CSR.
b) From the Certificate Name drop-down list, select tomcat.
c) Click Download CSR.

Step 3 Generate and download a CSR for the secondary Finesse server.
To open Cisco Unified Operating System Administration for the secondary server, enter the following URL
in the address bar of your browser:

https://hostname of secondary Finesse server/cmplatform

Step 4 Use the CSRs to obtain the CA root certificate, intermediate certificate, and signed application certificate
from the Certificate Authority.

To set up the certificate chain correctly, you must upload the certificates in the order described in
the following steps.

Note

Step 5 When you receive the certificates, select Security > Certificate Management > Upload Certificate.
Step 6 Upload the root certificate.

a) From the Certificate Name drop-down list, select tomcat-trust.
b) In the Upload File field, click Browse and browse to the root certificate file.
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c) Click Upload File.

Step 7 Upload the intermediate certificate.
a) From the Certificate Name drop-down list, select tomcat-trust.
b) In the Root Certificate filed, enter the name of the root certificate that you uploaded in the previous step.

Do not include the extension (for example, TEST Root CA 2048).
c) In the Upload File field, click Browse and browse to the intermediate certificate file.
d) Click Upload File.

Step 8 Upload the application certificate.
a) From the Certificate Name drop-down list, select tomcat.
b) In the Root Certificate field, enter the name of the intermediate certificate that you uploaded in the previous

step. Include the .pem extension (for example, TEST-SSL-CA.pem).
c) In the Upload File field, click Browse and browse to the application certificate file.
d) Click Upload File.

Step 9 After the upload is complete, sign out of Finesse.
Step 10 Access the CLI on the primary Finesse server.
Step 11 Enter the command utils service restart Cisco Finesse Notification Service to restart the Cisco Finesse

Notification service.
Step 12 Enter the command utils service restart Cisco Tomcat to restart the Cisco Finesse Tomcat service.
Step 13 Upload the application certificate to the secondary Finesse server.

You do not need to upload the root and intermediate certificates to the secondary Finesse server. After you
upload these certificates to the primary server, they are replicated to the secondary server.

Step 14 Access the CLI on the secondary Finesse server and restart the Cisco Finesse Notification Service and the
Cisco Tomcat Service.

Produce Certificate Internally

Set up Microsoft Certificate Server for Windows 2008 R2

This procedure assumes that your deployment includes aWindows Server 2008 R2 (Standard) Active Directory
server. Perform the following steps to add the Active Directory Certificate Services role on the Windows
2008 R2 (Standard) domain controller.

Procedure

Step 1 Click Start, right-click Computer, and selectManage.
Step 2 In the left pane, click Roles.
Step 3 In the right pane, click Add Roles.
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The Add Roles Wizard opens.

Step 4 On the Select Server Roles screen, check theActive Directory Certificate Services check box, and then click
Next.

Step 5 On the Introduction to Active Directory Certificate Services screen, click Next.
Step 6 On the Select Role Services screen, check the Certification Authority check box, and then click Next.
Step 7 On the Specify Setup Type screen, select Enterprise, and then click Next.
Step 8 On the Specify CA Type screen, select Root CA, and then click Next.
Step 9 Click Next on the Set Up Private Key, Configure Cryptography for CA, Configure CA Name, Set Validity

Period, and Configure Certificate Database screens to accept the default values.
Step 10 On the Confirm Installations Selections screen, verify the information, and then click Install.

Download CA certificate

This procedure assumes that you are using the Windows Certificate Services. Perform the following steps to
retrieve the root CA certificate from the certificate authority. After you retrieve the root certificate, each user
must install it in the browser used to access Finesse.

Procedure

Step 1 On the Windows domain controller, run the CLI command certutil -ca.cert ca_name.cer, in which ca_name
is the name of your certificate.

Step 2 Save the file. Note where you saved the file so you can retrieve it later.

Client-Side Certificate Acceptance
The procedures that agents must perform to accept certificates the first time they sign in depends on the method
you choose to manage certificates and the browser used by the agents.

Deploy Root Certificate for Internet Explorer
In environments where group policies are enforced via the Active Directory domain, the root certificate can
be added automatically to each user's Internet Explorer. Adding the certificate automatically simplifies user
requirements for configuration.

To avoid certificate warnings, each user must use the fully-qualified domain name (FQDN) of the Finesse
server to access the desktop.

Note
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Procedure

Step 1 On the Windows domain controller, navigate to Administrative Tools > Group Policy Management.
Users who have strict Group Policy defined on the Finesse Agent Desktop are required to disable
Cross Document Messaging from Group Policy Management to ensure proper functioning of
Finesse on Internet Explorer 11.

Note

Step 2 Right-click Default Domain Policy and select Edit.
Step 3 In the Group Policy Management Console, go to Computer Configuration > Policies >Window Settings

> Security Settings > Public Key Policies.
Step 4 Right-click Trusted Root Certification Authorities and select Import.
Step 5 Import the ca_name.cer file.
Step 6 Go to Computer Configuration > Policies >Windows Settings > Security Settings > Public Key Policies

> Certificate Services Client - Auto-Enrollment.
Step 7 From the Configuration Model list, select Enabled.
Step 8 Sign in as a user on a computer that is part of the domain and open Internet Explorer.
Step 9 If the user does not have the certificate, run the command gpupdate.exe /target:computer /force on the user's

computer.

Set Up Certificate for Internet Explorer Browser
After obtaining and uploading the CA certificates, either all users must accept the certificate or the certificate
must be automatically installed via group policy.

In environments where users do not log directly in to a domain or group policies are not utilized, every Internet
Explorer user in the system must perform the following steps once to accept the certificate.

Procedure

Step 1 In Windows Explorer, double-click the ca_name.cer file (in which ca_name is the name of your certificate)
and then click Open.

Step 2 Click Install Certificate > Next > Place all certificates in the following store.
Step 3 Click Browse and select Trusted Root Certification Authorities.
Step 4 Click OK.
Step 5 Click Next.
Step 6 Click Finish.

A message appears that states you are about to install a certificate from a certification authority (CA).

Step 7 Click Yes.
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A message appears that states the import was successful.

Step 8 To verify the certificate was installed, open Internet Explorer. From the browser menu, selectTools > Internet
Options.

Step 9 Click the Content tab.
Step 10 Click Certificates.
Step 11 Click the Trusted Root Certification Authorities tab.
Step 12 Ensure that the new certificate appears in the list.

Set Up Certificate for Firefox Browser
Every Firefox user in the system must perform the following steps once to accept the certificate.

To avoid certificate warnings, each user must use the fully-qualified domain name (FQDN) of the Finesse
server to access the desktop.

Note

Procedure

Step 1 From the Firefox browser menu, select Options.
Step 2 Click Advanced.
Step 3 Click the Certificates tab.
Step 4 Click View Certificates.
Step 5 Click Import and browse to the ca_name.cer file (in which ca_name is the name of your certificate).

Accept Security Certificates
If you use the self-signed certificates provided with Finesse, the first time users sign in to the Finesse desktop,
they are prompted to accept security certificates before they can continue. Unless the certificates are deleted,
they should only need to be accepted once on each client.

These certificates allow the Finesse desktop to communicate over a secure connection to the Finesse servers.

If an agent or supervisor is using a Windows client, signed in as a Windows user, and using Internet
Explorer to access the Finesse desktop, that agent or supervisor must run Internet Explorer as an
administrator to install the security certificates.

To run Internet Explorer as an administrator, in the Start menu, right-click Internet Explorer and select
Run as administrator.

Note
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Procedure

Step 1 Enter the URL for the Finesse desktop in your browser.
Step 2 If you use Internet Explorer:

a) A page appears that states there is a problem with the website's security certificate. Click Continue to
this website (not recommended) to open the Finesse sign-in page.

b) Enter your agent ID or username, password, and extension, and then click Sign In.
The following message appears:

Establishing encrypted connection...

A dialog box appears that lists the certificates to accept.

c) Click OK on the dialog box.
A new browser tab opens for each certificate you need to accept. A certificate error appears in the address
bar.

Depending on your browser settings, a window may open for each certificate you need to accept
instead of a browser tab.

Note

d) Click Certificate error and then click View Certificates to open the Certificate dialog box.
e) On the Certificate dialog box, click Install Certificate to open the Certificate Import Wizard.

If you are using Internet Explorer 11 withWindows 8.1, the Install Certificate option does not appear until
you add Finesse to your trusted sites.

1 From the browser menu, select Internet Options.

2 On the Security tab, click Trusted Sites, and then click Sites.

3 In the Add this website to the zone field, enter the URL for the Finesse desktop and click Add.

4 After you click Install Certificate, under Store Location, selectCurrent User to install the certificate
for the current user only, or select Local Machine to install the certificate for all Windows users who
use this computer.

If you selectLocalMachine, a dialog box appears that asks if you want to allowWindows host process
to make changes to this computer. Select Yes.

f) On the Certificate Import Wizard, click Next.
g) Select Place all certificates in the following store, and then click Browse.
h) Select Trusted Root Certification Authorities, and then click OK.
i) Click Next.
j) Click Finish.

A Security Warning dialog box appears that asks if you want to install the certificate.

k) Click Yes.
A Certificate Import dialog box that states the import was successful appears.

l) Click OK.
m) Click OK on the Certificate dialog box.
n) Close the browser tab. You are asked to accept another certificate. Repeat the preceding steps until all

certificates are accepted.
After you accept all required certificates, the sign-in process completes.

   Cisco Finesse Installation and Upgrade Guide Release 10.5(1)
34

Initial Configuration
Client-Side Certificate Acceptance



To remove the certificate error from the desktop, you must close and reopen your browser.Note

Step 3 If you use Firefox:
a) A page appears that states this connection is untrusted. Click I Understand the Risks, and then clickAdd

Exception.
b) Ensure the Permanently store this exception check box is checked.
c) Click Confirm Security Exception.

The Finesse sign-in page appears.

d) Enter your agent ID or username, password, and extension, and then click Sign In.
The following message appears:

Establishing encrypted connection...

A dialog box appears that lists the certificates to accept.

e) Click OK.
A browser tab opens for each certificate that you need to accept.

f) On each tab, click I Understand the Risks, and then click Add Exception.
g) Ensure the Permanently store this exception check box is checked.
h) Click Confirm Security Exception.

Each tab closes after you accept the certificate.

After you accept all required certificates, the sign-in process completes.

Ensure Agents Can Sign in to Desktop
After the system administrator defines configuration settings and restarts services, agents who have passwords
and operational handsets can sign in to the Finesse Agent Desktop.

After you restart Finesse, it takes approximately 6minutes for all server-related services to restart. Therefore,
you should wait 6 minutes before you attempt to sign in to the desktop.

Note

If you are using HTTPS, the first time you access the agent desktop, you see a browser security warning.
To eliminate browser security warnings each time you sign in, you can trust the self-signed certificate
provided with Finesse or obtain and upload a CA certificate.

Note

Procedure

Step 1 Enter the following URL in the address bar of your browser:
http://FQDN, hostname, or IP address of Finesse server/desktop
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Step 2 If you installed the language pack COP file, you can select the language you want to appear on the desktop
from the language selector drop-down list. If you did not install the language pack COP file, the language
selector drop-down list does not appear in the user interface.

If you installed the language pack COP file, you can also select a language by passing the locale as
part of the URL (for example, http://FQDN, hostname, or IP address of Finesse
server/desktop?locale=fr_FR) or by changing your browser preferred language. The default language
is English (en_US).

Note

Step 3 Enter your agent ID or username, password, and extension, and then click Sign In.

Figure 2: Desktop Sign-In

If your agent is signed into the Agent Desktop in Single Sign-On Mode or Hybrid Mode, refer to the sections
Sign In to Finesse Desktop Single Sign-On Mode or Sign In to Finesse Desktop Hybrid Mode in the Cisco
Finesse Desktop User Guide for Unified Contact Center Enterprise.

Ensure Failover Functions Correctly
Finesse provides a diagnostic tool that you can run on the Finesse desktop to ensure that failover is functioning
correctly.

For this tool to make an accurate diagnosis, the alternate Finesse server must be accessible and in serviceNote

Procedure

Step 1 Sign in to the Finesse desktop.
Step 2 Enter the following URL in the address bar of the browser:

http://FQDN, hostname, or IP address of Finesse server/desktop/failover

The tool performs a simulated failover test and displays the results. If the test passes, the following message
appears:
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Test sequence passed for failover to <Finesse alternate server name>. Click OK to test failback by running
the test sequence from <Finesse alternate server name>.

Step 3 Click OK to test failback.
If the failover test fails, the server may not be accessible (for example, certificate exceptions may be
blocking browser access). To ensure that this is not the case, try to access the alternate Finesse server
directly using the FQDN and manually sign in to the desktop. If sign-in succeeds, certain browser
settings or policies may be preventing failover fromworking properly. For example, accessing Finesse
with its hostname or IP address instead of the FQDNmay cause browsers to place client-side security
restrictions on access between the two servers because they are considered to be third-party to each
other. If the two servers are on the same domain and accessed with the FQDN, these restrictions are
not as strict.

Note

Related Topics

Browser Settings for Internet Explorer, on page 27

Configure DNS on Clients

This procedure is required for uncommon environments where non-hierarchical DNS configuration exists.
If your environment has hierarchical DNS configuration, you do not need to perform this procedure. This
procedure applies to clients that use aWindows operating system. For information about configuring DNS
on Mac clients, see your Apple documentation (www.apple.com/mac).

Note

Configuring DNS on client computers allows the clients to resolve the fully-qualified domain name (FQDN)
of the active Finesse server during a failover.

Procedure

Step 1 Go to Control Panel > Network and Internet > Network and Sharing Center. (Open the Control Panel,
enter Network Connections in the search bar, and then click View network connections.)

Step 2 Click the appropriate network connection.
A dialog box showing the status of the connection appears.

Step 3 Click Properties.
Step 4 On the Networking tab, select Internet protocol version 4 (TCP/IPv4), and then click Properties.
Step 5 Click Advanced.
Step 6 On the DNS tab, under DNS server addresses, in order of use, click Add.
Step 7 Enter the IP address of the DNS server that was entered during installation and click Add.
Step 8 If a secondary DNS was entered during installation, repeat Step 5 and Step 6 to add its IP address.
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Load Balancing for Finesse
After agents sign in to the Finesse desktop, the Finesse desktop client manages failover. For example, if a
Finesse server goes out of service, the Finesse client automatically redirects and signs the agent in to the other
Finesse server. The client can manage various network and server failure use cases. Given this client-side
logic, the use of a load balancer after sign-in is not required nor supported.

However, the following are two scenarios in which you can use a load balancer with Finesse.

These scenarios only apply to the Finesse desktop and not to Finesse IP Phone Agents.Note

When Agents Navigate to the Finesse Sign-In Page

If an agent attempts to navigate to a Finesse server that is down or not reachable, they cannot access the sign-in
page. The agent receives an error and must manually sign in to the other Finesse server. To avoid this manual
step, customers can use a load balancer using URL redirect mode to direct the agent to a Finesse server that
is operational. One option is to use the Finesse SystemInfo RESTAPI, which provides the status of the Finesse
server. For details about this API, see the Cisco Finesse Web Services Developer Guide.

When you configure a load balancer to determine the status of the Finesse servers, the call flow is as follows:

1 When agents sign in to Finesse, they point their browsers to the load balancer.

2 The load balancer redirects the agent browser to an appropriate Finesse server.

3 The agent signs in to the Finesse server directly. At this stage, the load balancer is no longer part of the
call flow.

When Customers Use the Finesse API Directly

If a customer uses the Finesse REST API directly, the Finesse client-side failover logic is not in the call flow.
In this case, customers can opt to use a load balancer to manage high availability. This load balancer is
considered part of a custom application which, like all custom applications, Cisco does not support. The
customer or partner must provide the required support for the load balancer.

Before you configure the load balancer, remember that there are two connections between Finesse clients and
the Finesse server:

• A REST channel for request and response

• An XMPP channel that the server uses to send notifications to the client

Both channels for a given client must connect to the same Finesse server.

You cannot connect the load balancer to the REST connection for one Finesse server and to the XMPP channel
connection for the other Finesse server. This setup provides unpredictable results and is not supported.
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Initial Configuration Troubleshooting
ThenIf

1 Clear your browser cache (delete browsing history and cookies).

2 If the problem persists, restart the Cisco Tomcat service or restart
the Finesse server.

The administration console does
not load after a fresh installation.
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ThenIf

1 Verify that the agent ID and password are correct.

2 Verify that a valid domain was configured during installation and
that forward and reverse DNS are set up correctly. To check whether
DNSwas configured during installation, check the install.log for the
following:

InstallWizard|USER_ACTION_BTN_PUSH: Screen = DNS Client
Configuration, button pushed = No|<LVL::Info

The precedingmessage indicates that DNSwas not configured during
the installation. Reinstall Finesse and configure the DNSwith a valid
domain.

3 Verify that the agent is configured in Unified CCE.

4 Verify that the AWDB is configured correctly.

a Check the realm.log for the following line:

"ERROR
com.cisco.ccbu.finesse.realms.ccerealm.CCERealmConfig -
Cannot connect to any AWDB! Ensure that at least one AWDB
is configured properly and running!"

This line indicates that Finesse cannot connect to the AWDB.

b Check that the values entered in the Contact Center Enterprise
Administration & Data Server Settings gadget are correct.

• Verify that the username entered is a Windows domain
user.

• Verify that the username is not prepended with the domain
(for example, domain\username).

• Verify that the port configured is open to the Finesse server.

c Check that the AWDB is set up correctly and running.

• TheAWDBSQL server must useWindows authentication.

• Verify that the AWDB server is up and that the Distributor
service is running.

5 Restart Cisco Tomcat on the primary and secondary Finesse servers.

6 Verify that the agent's device is properly configured in Unified
Communications Manager and is active.

Agents cannot sign in to the
desktop after a fresh installation.

Related Topics

Log Collection, on page 41
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A P P E N D I X  A
Cisco Finesse CLI

The CLI provides a set of commands applicable to the operating system and to Cisco Finesse. These commands
allow basic maintenance and failure recovery and enable some system administration.

Although Finesse provides access to all Cisco Unified Communications Manager CLIs, many commands
are not applicable to Finesse and most have not been validated for Finesse.

You can access the CLI directly, using the monitor and keyboard at the server console, or by SSH. Sign in
with the Administrator User credentials created during installation.

• Commands Supported for Cisco Finesse, page 41

Commands Supported for Cisco Finesse
Finesse supports the following CLI commands and has qualified their use.

Log Collection
These commands prompt you to specify a secure FTP (SFTP) server location to which the files will be uploaded.

To obtain logs:

• Install log: file get install desktop-install.log
Use this command to see the installation log after the system is installed.

This log is written to the SFTP server and stored as a text file written to this path: <IP Address>\<date
time stamp>\install\desktop-install.log

• Desktop logs: file get activelog desktop recurs compress
Use this command to obtain logs for the Finesse web applications. This command uploads a zip file that
contains the following directories:

◦webservices: This directory contains the logs for the Finesse backend that serves the Finesse REST
APIs. The maximum size of an uncompressed desktop log file is 100 MB. The maximum size of
this directory is approximately 4.5 GB. After a log file reaches 100 MB, that file is compressed
and a new log file is generated. Output to the last compressed desktop log file wraps to the log file
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created next. The log file wrap-up duration can vary, based on the number of users on the system.
Timestamps are placed in the file name of each desktop log.

◦finesseconfig: This directory contains the logs for the Finesse Config backend that serves the
Finesse Administration REST APIs. The maximum size of an uncompressed desktop log file is
100 MB. This directory holds a maximum of 300 log files. After a log file reaches 100 MB, that
file is compressed and a new log file is generated. Output to the last compressed desktop log file
wraps to the log file created next. The log file wrap-up duration can vary, based on the number of
users on the system. Timestamps are placed in the file name of each desktop log.

◦desktop: This directory contains logs from the Finesse agent desktop gadget container that holds
the Finesse desktop gadgets. Any container-level errors with Finesse agent desktop will appear in
these log files.

◦admin: This directory contains logs from the Finesse administration gadget container that holds
the administration gadgets. Any container-level errors with the Finesse administration console
appear in these log files.

◦clientlogs: This directory contains the client-side logs submitted from the Finesse agent desktop
to the Finesse server. Each log file is no larger than 1.5 MB and contains a timestamp and the agent
ID of the agent who submitted the file. A new log file is created each time an agent submits
client-side logs (the data is not appended to an existing log file). The maximum size of this directory
is 100 MB. When the directory reaches 100 MB, the oldest files are deleted to keep the size below
100 MB.

◦openfireservice: This directory contains startup and shutdown-related information logs for the
Cisco Finesse Notification Service.

◦openfire: This directory contains limited error and information logs for the Cisco Finesse
Notification Service.

◦finesse-dp: This directory contains start-up, error, and informational logs generated by the Finesse
Diagnostic Portal application.

◦jmx: This directory contains the JMX counters data generated by the JMX logger process. It
contains important jmx counters exposed by Finesse and openfire.

These logs are stored to the following path on the SFTP server: <IP address>\<date time
stamp>\active_nnn.tgz , where nnn is timestamp in long format.

• Servm log: file get activelog platform/log/servm*.* compress

Use this command to obtain logs generated by the platform service manager that manages the starting
and stopping of the Finesse services.

The desktop and servm logs are compressed to one set of files.

These logs are stored to the following path on the SFTP server: <IP address>\<date time
stamp>\active_nnn.tgz , where nnn is timestamp in long format.

• Platform Tomcat logs: file get activelog tomcat/logs recurs compress

These logs are stored to the following path on the SFTP server: <IP address>\<date time
stamp>\active_nnn.tgz , where nnn is timestamp in long format.

• VOS install log: file get install install.log
These logs are stored to the following path on the SFTP server: <IP address>\<date time
stamp>\active_nnn.tgz , where nnn is timestamp in long format.
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Log collection may fail when you use the compress flag if there are a lot of log files. If collection fails,
run the command again without the compress flag.

Note

Cisco Finesse HTTPS Redirect
Enable Cisco Finesse HTTPS Redirect to enforce HTTPS to access the Finesse desktop and administration
console. If Cisco Finesse HTTPS Redirect is enabled, agents and supervisors who attempt to access the desktop
with HTTP are redirected to HTTPS. Administrators who attempt to access the administration console with
HTTP are also redirected to HTTPS.

Cisco Finesse HTTPS Redirect is enabled by default.Note

If Cisco Finesse HTTPS Redirect is disabled, the desktop and the administration console can be accessed with
HTTP or HTTPS.

This command does not impact the Finesse REST APIs.Note

In a two-node setup, if you enable or disable HTTPS Redirect only on the primary Finesse server, the setting
does not replicate to the secondary Finesse server. You must enter the required commands on both the primary
and secondary Finesse server.

To view the status of, enable, or disable Cisco Finesse HTTPS Redirect:

• To retrieve the status of Cisco Finesse HTTPS Redirect: utils finesse application_https_redirect status
This command displays whether Cisco Finesse HTTPS Redirect is currently enabled or disabled on the
system.

• To enable Cisco Finesse HTTPS Redirect: utils finesse application_https_redirect enable
You must stop the Cisco Tomcat Service before you can enable Cisco Finesse HTTPS Redirect. You
can use the following command to stop this service: utils service stop Cisco Tomcat.

If the Cisco Tomcat Service is not stopped, the command to enable Cisco Finesse HTTPS Redirect fails.
This command also fails if Cisco Finesse HTTPS Redirect is already enabled.

After you enable Cisco Finesse HTTPS Redirect, start the Cisco Tomcat Service using the command
utils service start Cisco Tomcat.

• To disable Cisco Finesse HTTPS Redirect: utils finesse application_https_redirect disable
You must stop the Cisco Tomcat Service before you can disable Cisco Finesse HTTPS Redirect. You
can use the following command to stop this service: utils service stop Cisco Tomcat.

If the Cisco Tomcat Service is not stopped, the command to disable Cisco Finesse HTTPS Redirect fails.
This command also fails if Cisco Finesse HTTPS Redirect is already disabled.

After you disable Cisco Finesse HTTPS Redirect, start the Cisco Tomcat Service using the command
utils service start Cisco Tomcat.
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Finesse Services
To view, start, or stop services:

• To view the platform TCP/IP services, UDP services, and Unix domain sockets used by Cisco Finesse:
show network all detail

• To retrieve the status of services: utils service list
This command retrieves a list of all services and their status.

Services are shown in one of the following states: STOPPED, STARTING, or STARTED.

STOPPED means the service is not running. STARTING means the service is starting operation and
performing any necessary initialization. STARTED means the service has successfully initialized and
is operational.

• To start a service: utils service start service name
This command starts the named service.

• To stop a service: utils service stop service name

This command stops the named service.

• To start Cisco Tomcat: utils service start Cisco Tomcat

• To stop Cisco Tomcat: utils service stop Cisco Tomcat

• To restart Cisco Tomcat: utils service restart Cisco Tomcat

If a Cisco Finesse service-related problem exists, we recommend a restart of a Finesse
service as a last resort. Most service-related problems cannot be corrected by restarting
a service. Restarting A Cisco DB is never recommended.

Note

Cisco Finesse Notification Service Logging
To view the status of, enable, or disable Cisco Finesse Notification Service logging:

• To retrieve the status of Cisco Finesse Notification Service logging: utils finesse notification logging
status

This command displays whether Cisco Finesse Notification Service logging is currently enabled or
disabled on the system.

Ensure the Cisco Finesse Notification Service is running before you run the command
to retrieve the status of Cisco Finesse Notification Service logging. If the service is not
running, this command fails.

Note

• To enable Cisco Finesse Notification Service logging: utils finesse notification logging enable
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Ensure that the Cisco Finesse Notification Service is running before you run the command
to enable Cisco Finesse Notification Service logging. If the service is not running, this
command fails. This command also fails if Cisco Finesse Notification Service logging
is already enabled.

If you enable logging and then restart the Cisco Finesse Notification Service, logging
is automatically disabled.

Note

• To disable Cisco Finesse Notification Service logging: utils finesse notification logging disable

Ensure that the Cisco Finesse Notification Service is running before you run the command
to disable Cisco Finesse Notification Service logging. If the service is not running, this
command fails. This command also fails if the Cisco Finesse Notification Service logging
is already disabled.

Note

Upgrade
Upgrade-related commands are grouped under utils system upgrade.

To initiate an upgrade: utils system upgrade initate

This command allows you to install upgrades and Cisco Option Package (COP) files from both local and
remote directories.

To cancel an upgrade: utils system upgrade cancel

Remote Account Management
Run the following command to enable, disable, create, and check the status of a remote access account: utils
remote_account

A remote account generates a passphrase that allows Cisco support personnel to get access to the system for
the specified life of the account.

• utils remote_account create account life
account is the account name. life indicates the life of the account in days.

• utils remote_account disable

• utils remote_account enable

• utils remote_account status

Replication Status
To check replication status, run the following command on the primary Finesse server:
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• utils dbreplication runtimestate
This command returns the replication status on both the primary and secondary Finesse servers.

• Check the RTMT counter value for replication. If all nodes in the cluster show a replication status of 2,
replication is functioning correctly.

• If the RTMT counter value for replication status is 3 or 4 for all nodes in the cluster, replication is set
up but an error occurred and replication is not functioning properly.

• If the majority of the nodes show a value of 0 or 1, run the command utils dbreplication reset all from
the primary Finesse server.

• If any node shows any replication value other than 1 or 2, replication is not set up correctly.

• To fix replication, contact Cisco Technical Support.

3rdpartygadget Account
The 3rdpartygadget account is used to upload third-party gadgets to the Finesse server. Before you can use
this account, you must set the password.

If you plan to upload third-party gadgets to the Finesse server, you must have a developer support services
contract or work with a Cisco partner who has a developer support services contract. For more information
about uploading third-party gadgets, see the Cisco Finesse Web Services Developer Guide.

Note

To set (or reset) the 3rdpartygadget account password, access the CLI and run the following command:

utils reset_3rdpartygadget_password
You are prompted to enter a password. After you enter a password, you are prompted to confirm the password.

The password for the 3rdpartygadget account must be between 5 and 32 characters long and cannot contain
spaces or double quotes (").

Third-party gadgets are migrated across upgrades and included in DRS backup and restore.Note
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A P P E N D I X  B
Network and System Services Used for Cisco
Finesse

To view the platform TCP/IP services, UDP services, and Unix domain sockets that are used by Cisco
Finesse, access the CLI using the Administrator User credentials and enter the following command:

show network all detail

To view the system services that are used by Cisco Finesse, access the CLI using the Administrator User
credentials and enter the following command:

utils service list

The following services are enabled by default when Cisco Finesse starts. These services are essential for
product operation and must not be disabled.

• Cisco AMC Service[STARTED]

• Cisco Audit Event Service[STARTED]

• Cisco CallManager Serviceability RTMT[STOPPED]

• Cisco CallManager Serviceability[STOPPED]

• Cisco CDP Agent[STARTED]

• Cisco CDP[STARTED]

• Cisco Certificate Change Notification[STARTED]

• Cisco Certificate Expiry Monitor[STARTED]

• Cisco Database Layer Monitor[STARTED]

• Cisco DB Replicator[STARTED]

• Cisco DB[STARTED]

• Cisco DirSync[STOPPED]

• Cisco DRF Local[STARTED]

• Cisco DRF Master[STARTED]
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Cisco DRF Master must be started only on the Finesse primary (A Side) server.

Status on the Finesse primary (A Side) server must be “STARTED”. Status on the Finesse
secondary (B Side) server must be “STOPPED” Command Out of Service.

Note

• Cisco Finesse Notification Service[STARTED]

• Cisco Log Partition Monitoring Tool[STARTED]

• Cisco RIS Data Collector[STARTED]

• Cisco RTMT Reporter Servlet[STOPPED]

• Cisco Serviceability Reporter[STOPPED]

• Cisco Syslog Agent[STARTED]

• Cisco Tomcat Stats Servlet[STOPPED]

• Cisco Tomcat[STARTED]

• Cisco Trace Collection Service[STOPPED]

• Cisco Trace Collection Servlet[STOPPED]

• Host Resources Agent[STARTED]

• MIB2 Agent[STARTED]

• SNMP Master Agent[STARTED]

• SOAP -Log Collection APIs[STARTED]

• SOAP -Performance Monitoring APIs[STARTED]

• SOAP -Real-Time Service APIs[STARTED]

• System Application Agent[STARTED]
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A P P E N D I X  C
Port Utilization

Table 2: Cisco Tomcat

NotesTraffic
Direction

Remote
Protocol and
Port

Remote Device (Process or
Application Protocol)

Listener
Protocol and
Port

Listener
(Process or
Application
Protocol)

Unsecure port used for Finesse
Platform Administration
(administration console),
Finesse Platform Serviceability
(agent and supervisor desktop,
Web Services, and Desktop
Modules (gadgets) with the
Finesse desktop), and Finesse
Disaster Recovery System.

BidirectionalBrowserTCP 80, 8080HTTP

Secure port used for Finesse
Platform Administration
(administration console),
Finesse Platform Serviceability
(agent and supervisor desktop,
Web Services, and Desktop
Modules (gadgets) with the
Finesse desktop), and Finesse
Disaster Recovery System.

BidirectionalBrowserTCP 443,
8443

HTTPS
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Table 3: Platform Database

NotesTraffic
Direction

Remote
Protocol and
Port

Remote Device (Process or
Application Protocol)

Listener
Protocol and
Port

Listener
(Process or
Application
Protocol)

Informix Database Software
(IDS) access and replication

BidirectionalBrowserTCP 1501JDBC

Table 4: Cisco Finesse Notification Service

NotesTraffic
Direction

Remote
Protocol and
Port

Remote Device (Process or
Application Protocol)

Listener
Protocol and
Port

Listener
(Process or
Application
Protocol)

Unsecure XMPP connection
between the Finesse server and
custom applications on the
agent or supervisor desktops for
communication over HTTP.

BidirectionalBrowser, agent desktopTCP 5222XMPP

Secure XMPP connection
between the Finesse server and
custom applications on the
agent or supervisor desktops for
communication over HTTPS.

BidirectionalBrowser, agent desktopTCP 5223XMPP

Unsecure BOSH connection
between the Finesse server and
agent and supervisor desktops
for communication over HTTP.

BidirectionalBrowser, agent desktopTCP 7071BOSH
(HTTP)

Secure BOSH connection
between the Finesse server and
agent and supervisor desktops
for communication over
HTTPS.

BidirectionalBrowser, agent desktopTCP 7443BOSH
(HTTPS)
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Table 5: Platform System Services

NotesTraffic
Direction

Remote
Protocol and
Port

Remote Device (Process or
Application Protocol)

Listener
Protocol and
Port

Listener
(Process or
Application
Protocol)

SFTP access for hosted
third-party gadget support

BidirectionalTCP 22SFTP

Platform CLIBidirectionalSSH clientTCP 22SSH

Network time synchronizationBidirectionalNTP serverUPD 123NTP

The platformAMC service uses
this connection to allow the
RTMT tool to retrieve and
display platform alerts.

BidirectionalRTMT clientTCP 1090,
1099

Platform Alert
Manager and
Collector
(AMC) service

Used by the RISDC platform
service. The Real-time
Information Server (RIS)
maintains real-time Cisco
Unified CM information such
as device registration status,
performance counter statistics,
critical alarms generated, and
so on. The Cisco RISDC
service provides an interface
for applications, such as
RTMT, SOAP applications,
Cisco Unified CM
Administration and AMC to
retrieve the information that is
stored in all RIS nodes in the
cluster.

BidirectionalRTMT clientTCP 2555,
2556

Real-time
Information
Service Data
Collector
(RISDC)
service

DRF serviceBidirectionalPlatform Administration
webapp

TCP 4040Disaster
Recovery
Framework
(DRF) Master
Agent Service
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Table 6: Primary and Secondary Node Communication

NotesTraffic
Direction

Remote
Protocol and
Port

Remote Device (Process or
Application Protocol)

Listener
Protocol and
Port

Listener
(Process or
Application
Protocol)

The primary and secondary
Finesse servers use this XMPP
connection to communicate
with each other to monitor
connectivity.

BidirectionalTCP 5222XMPP
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